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1 About this manual
Welcome to version 6.4 of IBM® Rational® Focal Point, the most 
comprehensive solution on the market for Decision Support, Portfolio 
Management and Product Management.

This manual contains information on installing and setting up Rational Focal 
Point.

Typographical conventions
The following typographical conventions are used in this manual:

Typeface or Symbol Meaning

Bold Book titles, important items, and items that you can select, 
including buttons and menus. For example: Click Yes to 
continue.

Italic Book titles

Courier Commands, files, and directories; computer output. For 
example: Edit your .properties file.

> A menu choice. For example: Select File > Open. This 
means select the File menu, then select the Open command 
from it.

Related documentation
You'll find a PDF version of this manual :

• on the IBM® Rational® Solutions for Enterprise Lifecycle Management 
DVD

• in the Rational Software Information Center 
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Licensing options
2 Before you install
This chapter contains the following topics:

• Licensing options

• Prerequisites

Licensing options
You must have a software license to run Rational Focal Point. Obtain your 
Rational Focal Point license before you install the software.

For more information about licensing, see the IBM® Rational® Solutions 
Licensing Guide, which is available from the IBM® Rational® Solutions for 
Enterprise Lifecycle Management DVD, and from the IBM Rational Focal Point 
Support website at 
http://www.ibm.com/software/awdtools/focalpoint/support.

If you are upgrading
If you are upgrading from Rational Focal Point 5.4 or 5.4 01 you must request a 
new license file from IBM Rational Focal Point Support.

Prerequisites
Before you start installing, make sure that the following prerequisites are fulfilled:

• Check that you meet the system requirements for installing and running 
Rational Focal Point. Details of system requirements can be found in the 
readme file and on the IBM Rational Focal Point Support website.

• If you want to install the database on a separate partition, make sure that 
there is enough disk space for the database and its backup files to grow. 
Normally, a clean installation (with an empty database) needs 250 MB to be 
reserved for Rational Focal Point, Java, the application server, and the 
database server. The size of disk space needed for the database depends on 
what it will contain.

• Make sure that you have IBM® Rational® License Server TL 1.4 or 1.5 
installed.

• If you set up a clustered environment, make sure that the system time on the 
different servers is synchronized and differ less than one second.
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Chapter 2:   Before you install
If you are upgrading
• Create a backup of the database, in case something should go wrong.

• Make a note of any custom business rules you are using. When the 
installation of Rational Focal Point 6.4 is completed, you need to request the 
custom business rules you use from IBM Rational Focal Point Support for 
compatibility reasons. Only the common business rules are included in the 
installation. The common business rules are: ChoiceAttributeText, 
LinkByText, LinkInfo, LinkListAttributeSum, ListAttributeSum, 
MailImport, MatrixWriter, SetChoice, TextLog, and TrafficLight.

• Make a backup of any report images you are using.
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3 Installing Rational Focal Point on Windows
This chapter contains the following topics:

• Before you start

• Installing Java

• Installing the application server

• Installing the database

• Configuring the database

• Configuring Oracle

• Configuring DB2

• Installing Rational Focal Point

• Starting Rational Focal Point for the first time

Before you start
Before you start installing, read the Licensing options and Prerequisites in 
Chapter 2, “Before you install”.

You must install the following components before you can install Rational Focal 
Point:

• Java™ Runtime Environment (JRE) 6

• An application server, either IBM Websphere Application Server Community 
Edition 2.1 or Apache® Tomcat™ 5.5

• A database, either PostgreSQL®, DB2, or Oracle®

You can download Java Runtime Environment (JRE) 6 from:

http://java.sun.com/javase/downloads/index.jsp.

You can download Apache Tomcat from: 

http://archive.apache.org/dist/tomcat/tomcat-5/. 

You can download  Websphere Application Server Community Edition 2.1.1.1 
from:

http://www.ibm.com/developerworks/downloads/ws/wasce/ 

You can download PostgreSQL 8.X.X from:

http://www.postgresql.org/ftp/binary/.
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Installing Java
Download Java Runtime Environment (JRE) 6 as described in “Before you start,” 
on page 5 and follow the on-screen instructions to install the software, using the 
default settings.

Installing the application server
1. Make sure you have administrative access to the server.

2. Double click the application server that you downloaded during the 
preparations, either apache-tomcat-5.5.x.exe or 
wasce-setup-2.1.x.x-win.exe.

3. Follow the installation instructions of the selected application server.

Installing the database
Rational Focal Point can use a PostgreSQL, DB2 or Oracle database. In this 
document, the PostgreSQL installation is described in detail, for installation of 
Oracle and DB2, please refer to the installation documentation for each database. 

To install the PostgreSQL database:
1. Make sure you have Administrator access to the server.

2. If you are installing from DVD, put the IBM® Rational® Solutions for 
Enterprise Lifecycle Management DVD into your DVD-ROM drive, browse 
to the Rational Focal Point software and click to install the PostgreSQL 
database.

A security warning dialog box is displayed. Click Run to install PostgreSQL. 
Go to step 4.

3. If you downloaded focalpoint_server.zip from the website, download 
PostgreSQL 8.X.X from:
http://www.postgresql.org/ftp/binary/.
A security warning dialog box is displayed when opening the file. Click Run 
to install the PostgreSQL database.

4. The Welcome screen is displayed. Select the language you want to use and 
click Start.
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Installing the database
5. The following OpenSSL message may be displayed: 

If it is, search for the files specified and rename them. For example, rename 
libeay32.dll to libeay32.dll.old, then click OK in the message, and 
Next on the Welcome screen, which is displayed again.

The PostgreSQL Installation Notes screen is displayed. 

6. Read the information provided, then click Next.

The Installation Options screen is displayed.

Leave the default installation options, and enter the path to the folder you 
want to use for your PostgreSQL installation, or leave the default.

7. Click Next.

The Service Configuration screen is displayed.

By default, the service name is PostgreSQL Database Server 8.X, the 
account name is postgres, and the account domain is the name of the 
computer you are installing on. 
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You can use an existing account by typing an existing account name and 
password, or create a new one by entering an account name and password 
that does not currently exist. If you use an existing account, make sure it is 
not a member of the local administrator group.

8. Enter an Account name and a password in the Account password and 
Verify password boxes. 

Caution  The password must be long enough and must contain a 
combination of lower and upper case characters and numerals. 
Do not let the installer create a password for you.

9. Click Next.

10. If you entered an account name and password that does not currently exist, a 
query message is displayed. Click Yes to create the account.

The account is created, and a success message is displayed. 

11. Click OK.

The Initialize database cluster screen is displayed.

a. Select Accept connections on all addresses, not just localhost.
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Configuring the database
b. Select UTF-8 from the Encoding list. Since Rational Focal Point has 
support for Unicode characters, the database must be configured for a 
unicode character set, such as UTF-8.

c. Enter a Superuser name and Password. 

This is not the user name and password you entered when you created 
the Windows service in step 8 above. You must provide a different 
password than the one you provided for the service.

Keep a note of this user name and password. You will need it when you 
install the Rational Focal Point application.

12. Click Next.

The Enable procedural languages screen is displayed.

13. Click Next.

The Enable contrib modules screen is displayed.

14. Click Next.

The Ready to install screen is displayed.

15. Click Next.

The Installing screen is displayed while the necessary files are installed. 
When all the files have been installed, the Installation complete screen is 
displayed. 

16. Click Finish.

Configuring the database

Configuring the PostgreSQL database

1. Click Start Menu > All Programs > PostgreSQL 8.X > pgAdmin III.

2. Right-click on the database name, select Connect and enter the password 
for the database. This is the password you provided on the Initialize 
database clusters screen when you installed the PostgreSQL database.

3. Expand the database tree in the left hand pane, right-click on the Databases 
icon and select New Database.
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The New Database dialog box is displayed.

4. Type focalpoint in the Name field and click OK.

5. Close pgAdmin III.

6. Stop the PostgreSQL Database Server service:

a. Click Start Menu > Control Panel.

b. Double-click the Administrative Tools icon.

c. Double-click the Services icon.

d. Right-click PostgreSQL Database Server 8.X and select Stop.

7. Edit the PostgreSQL configuration file:

a. Navigate to C:\Program Files\PostgreSQL\8.X\data\.

b. Open the file pg_hba.conf in Notepad and change this line:

host    all         all         127.0.0.1/32         md5

to:

host    all         all         <IPNUMBER>/32         password

where <IPNUMBER> is the IP number of the Rational Focal Point computer 
where the application server is installed. If Focal Point and PostgreSQL are 
installed on the same server you can use the same IP number. You must 
change md5 to password. 
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c. Save and close the file.

8. Allow access for the database port through any existing firewall, or disable 
the firewall.

9. In the Services window, restart the PostgreSQL service. Right-click 
PostgreSQL Database Server 8.1 and select Start.

It is good practice to back up your PostgreSQL database regularly. See “Backing 
up,” on page 45.

Configuring Oracle

The following steps assume you have already installed the Oracle RDBMS. For 
Oracle specific issues please refer to your Oracle documentation.

To configure Oracle for Rational Focal Point:

1. Create a new Oracle instance. Make sure that the parameter NLS_SORT is 
set to BINARY_CI.

2. Create a database for the schema for Rational Focal Point. Ensure that the 
database is created with a unicode character set, e.g. AL32UTF8 to enable 
storing unicode characters as supported in Rational Focal Point.

3. Create a user to hold the schema for focalpoint. For example, CREATE USER 
focalpoint IDENTIFIED BY focalpoint.

4. Create three tablespaces FP_DATA, FP_INDEX and FP_BIGOBJ.

5. Grant unlimited quota to the focalpoint user on the newly created 
tablespaces.

6. Run focalpoint_grant.sql, (available in focalpoint_server.zip) as system in 
sqlplus with the focalpoint user as the first parameter. For example, 
@focalpoint_grant.sql focalpoint.

Configuring DB2

The following steps assume that you already have installed IBM® DB2® version 
9.5. Refer to the DB2 installation documentation for information on how to 
install DB2.

To configure DB2 for Rational Focal Point:

1. Edit the file createFocalDBSchema.sql, included in 
focalpoint_server.zip, as needed:
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a.If needed, change the Database Name FOCALDB to a database 
name of your choice.

b.If needed, change the names of the three tablespaces FP_DATA, 
FP_INDEX and FP_BIGOBJ.

c.For each tablespace, change the path to a suitable local directory. 
Make sure that the local directory has read and write 
permissions. 

d.Based on the server configuration, select size for each tablespace.

2. Run createFocalDBSchema.sql in the Command Editor of DB2, logged in 
as the DB2 administrator.

Specifying storage parameters for DB2

In server.xml there is a section for specifying storage parameters for DB2.

If your tablespace definitions differs from the default names FP_DATA, 
FP_INDEX and FP_BIGOBJ, update the storage parameters in server.xml 
accordingly:

<Environment description="Tablespace for data storage"
            name="focalpoint/dataStorage"
            type="java.lang.String"
            value="IN FP_DATA"/>

<Environment description="Tablespace to be used for indexes"
            name="focalpoint/indexStorage"
            type="java.lang.String"
            value="IN FP_INDEX"/>

<Environment description="Tablespace to be used for storing big 
objects"
            name="focalpoint/bigObjStorage"
            type="java.lang.String"
            value="IN FP_BIGOBJ"/>

Installing Rational Focal Point
1. Make sure that you have Administrator access on the server.

2. Shut down all Windows programs.

3. Stop the application server, Tomcat or Websphere.

4. If you are installing from DVD, put the IBM® Rational® Solutions for 
Enterprise Lifecycle Management DVD into your DVD-ROM drive, 
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browse to the Rational Focal Point software and click to run the Rational 
Focal Point Installer. 

A security warning dialog box is displayed. Click Run to install Rational 
Focal Point. Go to Step 6.

5. If you downloaded the focalpoint_server.zip, extract the files from the zip 
and double click FocalPointServer.exe. 

A security warning dialog box is displayed. Click Run to install Rational 
Focal Point.

The Welcome screen is displayed. 

6. Click Next.

The License Agreement screen is displayed.

7. If you accept the terms of the license agreement, select I accept and click 
Next.

The Server Selection screen is displayed. 

8. Select which application server that Rational Focal Point should run on and 
click Next.

The Choose Destination Location screen is displayed. 

9. Conditional: If you have installed WASCE as application server, 

1.Browse to the WASCE installation directory and click Next.

The Login Information screen is displayed.

2.Enter your login information for WASCE and click Next.

3. Browse to the folder you want to use for your Rational Focal Point 
installation, or leave the default, and click Next.

The License Information screen is displayed.

4. If you do not have details of your license, select I will supply license 
information later. This option is not recommended. For more information 
about licensing, see the IBM® Rational® Solutions Licensing Guide.

If you know the location of your Rational Focal Point license, type the 
information in the appropriate field.

• Rational license server

If you are using a floating license, enter the location of the license server 
in the form port@host, for example 19353@licenseserver.
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• Client license file

If you have a node-locked license, copy it to a folder on your machine 
and type the path to the file. Click Next.

5. The Focal Point Memory Allocation screen is displayed. The Maximum 
Memory size is automatically set. You can change this later if necessary. 

6. Click Next.

7. The Database Settings screen is displayed.

a. In the Database Type frame, select the database you want to use for 
Rational Focal Point.

b. In the Database Connection Parameters frame, make sure that the 
database connection parameters are the same as the settings that were 
made when installing Postgres, DB2 or Oracle, e.g. the database account 
password. This is critical. For Postgres, see Installing the database, step 
11.

8. Click Next.

9. Click Install. Conditional: If WASCE is installed, a message stating “Please 
wait for the Websphere Application Server to fully start before proceding...” 
is displayed. When the procedure is completed, click OK.

10. The InstallShield Wizard Complete screen is displayed. Select the option 
Yes, I want to restart my computer now.
14    IBM® Rational® Focal Point™ Installation Guide



Starting Rational Focal Point for the first time
11. Click Finish.

12. Conditional: If you are using an Oracle database, you must add the JDBC 
driver to the <Application server home>\common\lib directory. The JDBC 
driver is included in the Oracle database installation. You can also download 
it from Oracle: 
http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs
/jdbc_10201.html

Starting Rational Focal Point for the first time
1. Start the application server. Rational Focal Point is now runnning.

2. Open a web browser and enter the url to the Rational Focal Point login page, 
for example http://localhost:8080/fp/servlet/Login

The Rational Focal Point login page is displayed.

3. Type the login name admin and password focalpoint.

4. Click Login.

5. Click Preferences in the upper right corner. 

6. Click Profile/Password Settings and change the admin user’s password. If 
you want to change your user name, click Users/Manage Users in the 
Navigation Bar to the left.

7. To be able to use the client, you must have the latest Java 6 installed. Check 
which version you have installed by clicking Start Menu > Control Panel > 
Java > General > About. If you do not already have it installed, you can 
download Java support from Sun: Java Runtime Environment (JRE) 6 from 
http://java.sun.com/javase/downloads/index.jsp. 

8. Rational Focal Point is now ready for use. Do not forget to log out by 
clicking Logout in the upper right corner.
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4 Upgrading to Rational Focal Point 6.4 on 
Windows

This chapter contains the following topics:

• Before you start

• Upgrading Focal Point 5.4 to Rational Focal Point 6.4

• Upgrading Focal Point 6.x to Rational Focal Point 6.4

Before you start
Before you start installing read the Licensing options and Prerequisites in Chapter 
2, “Before you install”.

Note  You must request a new license from IBM Rational Focal 
Point Support. You cannot use your Rational Focal Point 5.4 
license with Rational Focal Point 6. This is because we have 
upgraded the version of FLEXnet and introduced 
date-versioned licensing

Note  If you are upgrading from 5.4 on an installation running on 
Oracle, or migrating to Oracle, extract focalpoint_grant.sql 
from focalpoint_server.zip and run it according to the 
instructions in “Configuring Oracle,” on page 11 before the 
upgrade.

You must have the following components installed before you can install Rational 
Focal Point:

• Java Runtime Environment 6

• An application server, either IBM Websphere Application Server Community 
Edition 2.1 or Apache® Tomcat™ 5.5

• A database, either PostgreSQL®, DB2, or Oracle®

You can download Java Runtime Environment (JRE) 6 from:

http://java.sun.com/javase/downloads/index.jsp.

You can download Apache Tomcat from: 

http://archive.apache.org/dist/tomcat/tomcat-5/. 
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You can download  Websphere Application Server Community Edition 2.1.1.1 
from:

http://www.ibm.com/developerworks/downloads/ws/wasce/ 

You can download PostgreSQL 8.x from:

http://www.postgresql.org/ftp/binary/.

Upgrading Focal Point 5.4 to Rational Focal Point 6.4

Preparations
1. Make a backup of the old database before upgrading. See “Backing up and 

restoring the PostgreSQL database on Windows,” on page 39.

2. Back up report images, if any, located at <INSTALLDIR>\images. 
<INSTALLDIR> for Focal Point 5.4 is normally C:\Program 
Files\Telelogic\Focal Point 5.4\

3. Make a note of any used custom business rule in 
<INSTALLDIR>\formulas. When the installation of Rational Focal 
Point is finished, you need to request the custom business rules you use from 
IBM Rational Focal Point support for compatibility reasons. Only the 
common business rules are included in the installation. The common 
business rules are: ChoiceAttributeText, LinkByText, LinkInfo, 
LinkListAttributeSum, ListAttributeSum, MailImport, MatrixWriter, 
SetChoice, TextLog, and TrafficLight. Incompatible business rules will be 
ignored.

4. Stop the application service.

Upgrading Focal Point

1. Go to Start Menu > Control Panel > Add or Remove Program to 
uninstall Focal Point 5.4.

2. Install Rational Focal Point 6.4.

See “Installing Focal Point,” on page 12.

Note  When upgrading, Rational Focal Point defaults the 
application server port to 80. Conditional: If you use a 
port other than port 80 for Tomcat, you will have to edit 
the file Apache Software 
Foundation/Tomcat 
5.5/conf/server.xml after you install Rational 
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Upgrading Focal Point 6.x to Rational Focal Point 6.4
Focal Point. Change the port number in the line 
<Connector port="80". 

3. Start the application server. Rational Focal Point is running.

4. Start Focal Point by opening a web browser and entering the url to the 
Rational Focal Point login page, for example 
http://localhost:8080/fp/servlet/Login

5. Log in. Conditional: If the upgrade includes database changes, you will be 
asked to confirm the database update: 

a.Ensure that you have a backup of the database.

b.Click Yes to confirm the database update. The database update 
can take some time depending on the size of the database. 
When the database has been updated, the updated workspaces 
will be displayed.

c.Restart Rational Focal Point by stopping and starting the 
application server. 

d.In your web browser, enter the Rational Focal Point login page 
URL again.

The Rational Focal Point login page is displayed.

Configuring Rational Focal Point

6. When you have received the custom business rules from IBM Rational Focal 
Point Support, log on to Rational Focal Point and go to Advanced > 
Business Rules. Import the custom business rules files to the database. 
Instructions are available in the online help.

7. In Rational Focal Point, go to General > Report Images to import the 
backed up images into the database. Instructions are available in the help.

8. If you have any saved baselines in your database, you need to migrate them 
to the new architecture in Rational Focal Point 6. In Rational Focal Point, go 
to Advanced > Migrate Baselines. Instructions are available in the online 
help.

Upgrading Focal Point 6.x to Rational Focal Point 6.4
On Windows, Focal Point 6.x is upgraded to Rational Focal Point 6.4 by 
removing Focal Point 6.x and installing Rational Focal Point 6.4 in the same 
location. 
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Preparations: 
• Locate the Rational Focal Point installer at the IBM® Rational® Solutions 

for Enterprise Lifecycle Management DVD, or download Rational Focal 
Point 6.4 Installer for Windows from the IBM Rational Focal Point Support 
Download site.

• Make a note of the location of the current Focal Point 6.x installation.

• Keep the Database User Name and Password for the database account used 
by Focal Point close at hand during the upgrade.

• Ensure that the database is running.

Upgrading:

1. Go to Start Menu > Control Panel > Add or Remove Program and 
follow the instructions to uninstall Focal Point 6.x.

2. Install the new version of Rational Focal Point, following the instructions for 
“Installing Focal Point,” on page 12.

Note  When upgrading, Focal Point defaults the application 
server port to 80. Conditional: If you use a port other 
than port 80 for Tomcat, you will have to edit the file 
Apache Software Foundation/Tomcat 
5.5/conf/server.xml after you install Rational 
Focal Point. Change the port number in the line 
<Connector port="80". 

3. Start the application server.

4. Start Focal Point by opening a web browser and entering the url to the 
Rational Focal Point login page, for example 
http://localhost:8080/fp/servlet/Login

5. Login.
Conditional: If the upgrade includes database changes, you will be asked to 
confirm the database update: 

a.Ensure that you have a backup of the database.

b.Click Yes to confirm the database update. The database update 
can take some time depending on the size of the database. 
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When the database has been updated, the updated workspaces 
will be displayed.

c.Restart Rational Focal Point by stopping and starting the 
application server. 

d.In your web browser, enter the Rational Focal Point login page 
URL again.

The Rational Focal Point login page is displayed.
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5 Installing Rational Focal Point on UNIX
This chapter describes how to set up your UNIX environment for Focal Point. 
This guide covers installation, upgrade and maintenance of Rational Focal Point 
on UNIX.

Note  This manual assumes the reader is a System Administrator 
with a technical understanding of the supported operating 
systems.

• Before you start

• Installing Java

• Installing the application server

• Installing Rational Focal Point

• Installing the database

• Installing Rational Focal Point

• Configuring the application server

• Maintaining Rational Focal Point

• Monitoring Rational Focal Point

Before you start
Before you start installing, read the Licensing options and Prerequisites in 
Chapter 2, “Before you install”.

You can download Java Runtime Environment (JRE) 6 for Solaris from:

http://java.sun.com/javase/downloads/index.jsp.

You can download Java Runtime Environment (JRE) 6 for Linux from: 

http://www.ibm.com/developerworks/java/jdk/linux/download.html

You can download Apache Tomcat from: 

http://archive.apache.org/dist/tomcat/tomcat-5/

You can download Websphere Application Server Community Edition 2.1.1.1 
from:

http://www.ibm.com/developerworks/downloads/ws/wasce/
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Before you start installing, also make sure that the following prerequisites are 
fulfilled:

1. Make sure that you have Administrator access to the servers.

2. If you want to install the database on a separate partition, make sure that 
there is enough disk space for the log files, the database and its backup files 
to grow. Usually, a clean installation needs 250 MB to be reserved for 
Rational Focal Point. 

Monitor the amount of space left on the different partitions on the Rational 
Focal Point server to make sure that the partition where the database is 
installed never runs out of space. 

It is good practice to keep the backup directory and the database directory 
on separate disks. This means that the database is not affected if the database 
backups fill up the partition where the backup directory is located.

3. On Solaris, the following commands must be accessible during and after 
install (used by Rational Focal Point scripts and the installer):

/usr/ucb/ps awk cat

chown crontab cut 

ed grep ksh 

ln mkdir mv 

rm sh su 

tar touch zcat 




In addition to the core operating system the following components are 
needed: zip and gunzip (in package SUNWgzip) and perl (in package 
SUNWpl5u). You can test compliance (both commands and their versions) 
by running the script testfp.sh (Included in the downloaded .tar file). The 
output from this script should say “All checks passed.”. If not, please refer to 
your system documentation for instructions on how to install missing 
components.
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4. Rational Focal Point uses the following ports on the server by default:

Port Usage

5432 Database

7091 Ajp13 protocol

8091 Tomcat HTTP

80 Apache HTTP

8011 Tomcat control port

5. The user postgres (group postgres) will be created on the system by the 
PostgreSQL installation package if it does not already exist. This user is used 
for running the PostgreSQL database. 

Installing Java
1. Check that your current Java version is 1.6.0_XX by running 

java -version

in your shell. A correct result could look like:

java version "1.6.0_XX"
Java(TM) SE Runtime Environment (build 1.6.0_XX)
Java HotSpot(TM) Client VM (build 1.6.0_XX, mixed mode) 

2. If you do not have Java 1.6 installed or your version of Java does not 
correspond to the one above, you will need to install Java Runtime 
Environment (JRE) 6.

Download Java for your system according to the instructions in “Before you 
start” on page 23 and install it according to the Java installation instructions.

Installing the application server
Apache Tomcat is currently included in the Rational Focal Point installation. 

 Websphere Application Server Community Edition 2.1.1.1
Install wasce_setup-2.1.x.x-unix.bin that you downloaded during 
the preparations. 

Note: The directories in the installation path should not contain any spaces. 
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Installing Rational Focal Point
All the necessary Rational Focal Point installation files can be downloaded from 
the IBM Rational Focal Point Support Download site. For the basic installation, 
you need the focalpoint-6.4.sh file.

1. Put the installation file in a directory of your choice, here 
<installerdir>.

2. Go to the directory where you want to install Rational Focal Point. Make 
sure that you have write permissions in that directory.

3. Run the self-extracting installer by issuing the command:

sh <installerdir>/focalpoint-6.4.sh

You will be asked to read and understand the license agreement. Make sure you 
do so. If you do not agree, then answer no and press Enter and nothing will be 
installed on your system. Installation can be started again at any time. If you agree 
with the license terms, then answer yes and press Enter. A directory named fp 
will be created in the current directory. This directory will be denoted <fp> 
from now on.

Installing the database

PostgreSQL DBMS Support
Rational Focal Point can be configured to use the open source DBMS 
PostgreSQL.

Red Hat® Enterprise Linux®

Red Hat Enterprise Linux 4

If you are installing PostgreSQL on Red Hat Enterprise Linux 4, get the latest 
8.X.X postgresql packages for your architecture from the PostgreSQL web site 
available at:

http://www.postgresql.org/ftp/binary/

For example, if you are running on a 32 bit intel architecture, download the 
following three packages:

postgresql-server-8.X.X-XPGDG.rhel4.i386.rpm

postgresql-libs-8.X.X-XPGDG.rhel4.i386.rpm

postgresql-8.X.X-XPGDG.rhel4.i386.rpm
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Install them by running the following command (one line):

rpm -Uvh postgresql-server-8.X.X-XPGDG.rhel4.i386.rpm 
postgresql-libs-8.X.X-XPGDG.rhel4.i386.rpm 
postgresql-8.X.X-XPGDG.rhel4.i386.rpm

When the packages have been installed, make sure that the DBMS is started, and 
that it starts automatically when the server boots:

service postgresql initdb
service postgresql start
chkconfig postgresql on

Red Hat Enterprise Linux 5

Install the PostgreSQL packages by running the following command:

yum install postgresql-server

When the packages have been installed, make sure that the DBMS is started, and 
that it starts automatically when the server boots:

service postgresql start
chkconfig postgresql on

Create database and user

Use the script <fp>/scripts/postgresql/postgres_create.sh to create a database 
and database user for Rational Focal Point. Note that you will have to make the 
script executable before running it. 

Solaris

Install PostgreSQL according to the instructions available at Sun:

http://www.sun.com/software/solaris/howtoguides/postgresqlhowto.jsp

Oracle RDBMS Support

Rational Focal Point supports using Oracle RDBMS. This requires a properly 
installed and configured Oracle 10g. The following steps are required to use 
Oracle:

1. Create a new Oracle instance. Make sure that the parameter NLS_SORT is 
set to BINARY_CI.

2. Create a database for the schema for Focal Point. Ensure that the database is 
created with a unicode character set, e.g. AL32UTF8 to enable storing 
unicode characters as supported in Focal Point.
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3. Create a user to hold the schema for focalpoint. For example, CREATE USER 
focalpoint IDENTIFIED BY focalpoint.

4. Create three tablespaces FP_DATA, FP_INDEX and FP_BIGOBJ.

5. Grant unlimited quota to the focalpoint user on the newly created 
tablespaces.

6. Download JDBC Driver 10g from 
http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/index.ht
ml and copy the jar-file to <fp>/apache-tomcat-5.5.x/common/lib. 

7. Modify the properties in <fp>/catalinabaseX/conf/server.xml to 
match your Oracle settings. Under <Resource name="jdbc/focalpoint" 
the relevant property lines should look something like this: 

driverClassName="oracle.jdbc.OracleDriver"
url="jdbc:oracle:thin:@localhost:1521:FOCL"
username="focalpoint"
password="focalpoint"
maxActive="10"
connectionProperties="SetBigStringTryClob=true"

where hostname (localhost), port number (1521) and sid (FOCL) may have 
to be altered in the url property, and username and password should match 
the user in step 2. 

Make sure the max active connections for the database pool do not exceed 
the number of allowed sessions in Oracle.

8. Run focalpoint_grant.sql in <fp>/scripts/oracle as system in sqlplus 
with the focalpoint user as the first parameter, for example, 
@focalpoint_grant.sql focalpoint.

Specifying storage parameters for Oracle

In server.xml there is a section for specifying storage parameters for Oracle.

If your tablespace definitions differs from the default names FP_DATA, 
FP_INDEX and FP_BIGOBJ, update the storage parameters accordingly.

Add the following storage parameters to server.xml: 

  <Environment description=""
      name="focalpoint/dataStorage"
      type="java.lang.String"
      value="TABLESPACE FP_DATA
    STORAGE (initial 1m next 1m pctincrease 0)"/>
    
    <Environment description=""
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Installing the database
      name="focalpoint/indexStorage"
      type="java.lang.String"
      value="TABLESPACE FP_INDEX
    STORAGE (initial 1m next 1m pctincrease 0)"/>
    
   <Environment description=""
      name="focalpoint/bigObjStorage"
      type="java.lang.String"
      value="TABLESPACE FP_BIGOBJ
    STORAGE (initial 1m next 1m pctincrease 0)"/>

Backup

If you use Oracle, back up the database according to standard procedures.

Restore

If you use Oracle, restore the database according to standard procedures. Run 
the following SQL query before you start Rational Focal Point:

delete from node;

Convert to Oracle

Please contact support for scripts and instructions. (See “Contacting IBM 
Rational Software Support” on page 53.) 

DB2 Support

Rational Focal Point supports using IBM® DB2® version 9.5. The following 
steps assume that you already have installed IBM® DB2® version 9.5. Refer to 
the DB2 installation documentation for information on how to install and 
configure DB2.

If you are installing DB2 on RedHat Enterprise Linux 4 or 5, check for the DB2 
installation prerequisites and get the latest DB2 9.5[Enterprise or Express-C] 
edition for 32 bit or 64 bit Linux.

The following steps are required to use DB2:

1. To configure DB2 for Rational Focal Point, edit 
createFocalDBSchema.sql in <fp>/scripts/db2 and make changes to the 
batch sql as needed:

a. If needed, change the default Database Name FOCALDB to a database 
name of your choice.
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b. If needed, change the default names of the three tablespaces FP_DATA, 
FP_INDEX and FP_BIGOBJ.

c. For each tablespace, change the path in the container clause to a suitable 
local directory, for example on RedHat Enterprise Linux, change the file 
storage directory from USING (FILE 'D:\DB2\fp_data_cont11')  to  
USING (FILE '\root\DB2\fp_data_cont11'). Make sure that the local 
directory has read and write permissions. 

d. Based on the server configuration, select size in the container clause of 
each tablespace.

2. Download JDBC Driver for DB2 from 
https://www14.software.ibm.com/webapp/iwm/web/preLogin.do?lang=e
n_US&source=swg-idsjs11 and copy the jar file to  
<fp>/apache-tomcat-5.5.x/common/lib

3. Modify the properties in <fp>/catalinabaseX/conf/server.xml, to match 
your DB2 settings. Under <Resource name="jdbc/focalpoint" the relevant 
property lines should look something like this:

driverClassName="com.ibm.db2.jcc.DB2Driver"
url="jdbc:db2://localhost:50000/FOCALDB"
username="focalpoint"
password="focalpoint"
maxActive="10"

where hostname (localhost), port number (50000) and database name 
(FOCALDB) may have to be altered in the url property.

Make sure the max active connections for the database pool do not exceed the 
number of allowed sessions in DB2.

4. Logged in as the DB2 instance user, run createFocalDBSchema.sql by 
entering db2 -tvf createFocalDBSchema.sql in the DB2 command 
window. 

Specifying storage parameters for DB2

In server.xml there is a section for specifying storage parameters for DB2.

If your tablespace definitions differs from the default names FP_DATA, 
FP_INDEX and FP_BIGOBJ, update the storage parameters accordingly. 

Add the following storage parameters to server.xml:

<Environment description="Tablespace for data storage"
            name="focalpoint/dataStorage"
            type="java.lang.String"
            value="IN FP_DATA"/>
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<Environment description="Tablespace to be used for indexes"
            name="focalpoint/indexStorage"
            type="java.lang.String"
            value="IN FP_INDEX"/>

<Environment description="Tablespace to be used for storing big 
objects"
            name="focalpoint/bigObjStorage"
            type="java.lang.String"
            value="IN FP_BIGOBJ"/>

Backup

If you use DB2, back up the database according to standard procedures.

Restore

If you use DB2, restore the database according to standard procedures. Run the 
following SQL query before you start Rational Focal Point:

delete from node;

Converting to DB2

DB2 is only available for new installations of Rational Focal Point, currently 
there is no supported migration path to DB2. 

Configuring the application server

 Websphere Application Server Community Edition 2.1.1.1

Install dependency jars

In <fp>/wasce/, run geronimo_configure.sh.

Specify the JAVA_OPTS

Linux: 

1. Modify <WASCE_HOME>/bin/setenv.sh

2. Include the following entry in setenv.sh as the first line
JAVA_OPTS="-Xmx1024m -XX:MaxPermSize=384m 
-Dorg.apache.geronimo.jaxws.builder.useSimpleFinder=true 
$JAVA_OPTS"
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Install License libraries

Include libtl_lic.so in the java.library.path

32 bit Solaris: 
Place libtl_lic.so under /usr/lib/32

64 bit Solaris:
Place libtl_lic.so under /usr/lib/64
64 bit Linux: 
Place libt_lic.so under /usr/lib

Configuring used ports

If you identify port conflicts, you can change the ports used in
<WASCE_HOME>/var/config/config-substitutions.p
roperties

Note: Stop the WASCE server before making the modifications. 

Starting and stopping  Websphere Application Server Community Edition 2.1.1.1

To start the server

1. Go to <WASCE_HOME>/bin

2. Run startup.sh

To stop the server 

1. Go to <WASCE_HOME>/bin

2. Run shutdown.sh

References to  Websphere Application Server Community Edition 2.1.1.1 documentation
• System requirements - 

http://publib.boulder.ibm.com/wasce/V2.0.0/en/administration.html
• Creating server assemblies - 

http://www.ibm.com/developerworks/websphere/library/techarticles/0807_jain/0
807_jain.html#heading1

• Check list - 
http://www.ibm.com/developerworks/websphere/techjournal/0810_supauth/0810
_supauth.html

• WASCE administration - 
http://publib.boulder.ibm.com/wasce/V2.0.0/en/administration.html
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Basic setup without clustering
1. Become root.

2. cd into <fp> created by the installer script. Edit focalpoint.conf. Read the 
comments on each individual variable in the file for a short explanation.

3. Ensure that the application server has correct database pool settings, see 
step 4 for Tomcat, or step 5 for Websphere.

4. Edit database parameters (Tomcat). Go to 
catalinabase1/conf/server.xml, and edit the database 
parameters of the Resourcejdbc/focalpoint:

a. url: The URL identifying the database. The port number is by default 
5432.

b. username: By default, postgres on Solaris and focalpoint on RedHat 
Linux.

c. password: By default, dbasql.

d. defaultAutoCommit: verify that defaultAutoCommit is set 
to true.

5. Edit database parameters (Websphere): 

a. Select deployment plan - Depending on the database type used, select 
one of the following deployment plans in <fp>/wasce/:
- postgres_deployment-plan.xml
- db2_deployment-plan.xml 
- oracle10g_deployment-plan.xml

b. Change the default database name - Change all occurrences of 
fpdbpool in the database deployment plan to the desired database 
name.
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Note: The name should not contain the characters slash, backward slash 
or space.

c. In<fp>/wasce/geronimo_deploy_dbpool.sh, uncomment 
the required database pool and comment out other database pool 
configurations.

d. Update geronimo-web.xml in <fp>/wasce/ with the new 
dbpool name.

e. Deploy the database configuration by running 
geronimo_deploy_dbpool.sh. 

f. Deploy Rational Focal Point by running geronimo_deploy.sh.

6. Start Rational Focal Point.

a. Run command:

./startnode.sh 1

Go to the login page (http://<server>:8091/fp/servlet/Login) and 
verify that you get the page correctly. Make sure that you modify the 
portnumber in the URL according to your server.xml file or deployment 
plan. Upgrades only: If you are upgrading Focal Point and the upgrade 
includes database updates, you will be asked to confirm the database 
update. Click Yes and wait until the upgrade has finished. Then restart 
Rational Focal Point when prompted, by issuing the following 
commands

cd <fp>
./stopnode.sh 1
./startnode.sh 1

Go back to the login page (http://<server>:8091/fp/servlet/Login) and 
verify that the page is accessible. 

Start script
To make Rational Focal Point start whenever the system starts, a start script is 
needed in:

/etc/init.d/

and also some links to it in:

/etc/rcX.d/

Consult your system documentation for details on these scripts and links. We 
provide a sample of a start script in:

<fp>/scripts/focalpoint
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that should work on any UNIX-like system. If you use that, make sure that you 
edit the BASEDIR and NODES variables to reflect your setup.

After the focalpoint start script is configured you should be able to start and stop 
all your local nodes by issuing the following commands:

/etc/init.d/focalpoint start
/etc/init.d/focalpoint stop

Setting up a cluster with application server Apache Tomcat

1. Perform step 1-4 and 6 in “Basic setup without clustering” on page 33.

2. At this point you should have one Rational Focal Point node running. Set a 
multicast group address in the database. It should be an unused 
“Administratively-scoped (local) multicast address” on your network. Make 
sure that it does not interfere with other multicasts on your network. To set 
239.0.0.1 as multicast address, go to the login page 
(http://<server>:8091/fp/servlet/Login) and log in (The default user name 
is admin with password focalpoint). Go to Advanced > SQL and insert the 
following in the topmost text area and click Execute:

insert into projectsetting (pid,name,value) select 
projectid,’multicast.group.address’,’239.0.0.1’ from toc 
where type=’allusers’;

3. Stop Rational Focal Point:

./stopnode.sh 1

4. Copy <fp>/catalinabase1 into as many nodes as you want on this machine. 
Normally you only want one node per machine. If you want two nodes on 
this machine:

cp -r -p catalinabase1 catalinabase2

5. For each node, edit <fp>/catalinabase<X>/conf/server.xml 
where <X> is the node number:

a. Set the node name by setting the jvmRoute=”worker<Y>” 
attribute of the Engine element. This name must be unique across all 
nodes in the cluster. <Y> should be replaced by an integer.

b. If you want to run multiple nodes on this machine you also need to edit 
the following port numbers in server.xml, so that they do not clash with 
other nodes on this machine. Any port number above 1024 will do, but 
the easiest way is to replace the last digit in the port numbers with the 
number of the node.

1.Modify the port attribute of the Server element.
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2.Set http connector port number to be used by the node. It should look 
something like this if you want to use port 8092:

<!-- Define a non-SSL HTTP/1.1 Connector on port 8080 -->
<Connector port=”8092” maxHttpHeaderSize=”8192”

3.Set ajp port numbers to be used by the node. It should look something 
like this if you want to use port 7092:

<!-- Define an AJP 1.3 Connector on port 8009 -->
<Connector port=”7092”

4. Start the first node by entering 
./startnode.sh 1
Check the log written to <fp>/catalinabase1/logs to ensure that 
the first node is working properly.

5. Start remaining node(s) by entering
./startnode.sh <X>
where <X> is the node number

Setting up a cluster with Websphere Application Server Community Edition 2.1.1.1

1. Setting up the cluster configuration for database.

2. Configure the database pool for WASCE, see “Edit database parameters 
(Websphere):” on page 33.

3. Open config.xml in<WASCE_HOME>/var/config/
Search for the module "org.apache.geronimo.configs/tomcat6/2.1.1/car"
Add the following gbean immediately after the module as follows:
<gbean name="TomcatEngine">
 <attribute name="initParams">name=WASCE
jvmRoute=node1</attribute>
</gbean> 
where node1 is the desired node name.

4. Optionally modify PortOffset with the desired offset in 
<WASCE_HOME>/var/log/config-substitution.properties
Note: If PortOffset is set to 5, all port numbers specified will be increased 
by 5.

5. In geronimo-web.xml, modify tcpListenAddress with the IP 
address of the server where WASCE is configured.

6. Create another copy of the WASCE folder, for example WASCE2.
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7. Repeat the steps 3 and 4 for the next node. 
Note: Give the new node a different name, for example node2. 
Note: Specify a different PortOffset value for the new node.

8. Start WASCE, see “To start the server” on page 32.

9. Deploy Rational Focal Point with WASCE by running 
geronimo_deploy.sh.

10. After WASCE is started, start WASCE2.

11. Deploy Rational Focal Point with WASCE by running 
geronimo_deploy.sh.

12. Access the focalpoint urls with the assigned port numbers.
Note: If a single machine is used for testing purposes, open two different 
Web browsers and test the focalpoint application.

Setting up load balancing using mod_proxy

Load balancing can be done in several ways. There are a number of requirements 
that need to be met:

• Sticky sessions: All sessions must stay on the same node during the session.

• Ajp 1.3 or http can be used between the load balancer and the nodes.

The method described here is not in any way superior to other ways of load 
balancing, but it has been tested. It is good practice to use a separate machine for 
load balancing even though you can, for testing purposes, set up load balancing 
on one of your nodes’ machine. 

To set up a load balancer using Apache 2.2, you need to have mod_proxy, 
mod_proxy_balancer and mod_proxy_http or mod_proxy_ajp (depending on 
what protocol you have selected in server.xml on your nodes) loaded. The 
following Apache configuration snippet will set up a simple load balancer called 
mycluster. All requests coming to "/fp/*" will be routed into the load balancer. 
The load balancer will try to distribute the sessions evenly between the two 
nodes.

This is an example configuration, assuming the above mentioned modules are 
loaded, that sets up a load balancer with two nodes on Apache 2.2. For details on 
mod_proxy_balancer, please refer to 
http://httpd.apache.org/docs/2.2/mod/mod_proxy_balancer.html

######## balancer configuration #############################

<Location /balancer-manager>
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# This is the location where you can get status information
# about the load balancer. You can enable and disable the nodes
# as well as modify the balance between the nodes

SetHandler balancer-manager

# Only let local connections manage the balancer
Order Deny,Allow
Deny from all
Allow from 127.0.0.1
</Location> 

<Location /fp>
# We will only allow access from local network
Order Deny,Allow
Deny from all
Allow from 192.168.0.0/24
Allow from 127.0.0.1
</Location>

<Proxy balancer://mycluster>
# Here are the two nodes and their names (worker1 and worker2)
# These nodes are both running on this machine.
BalancerMember http://127.0.0.1:8091/fp route=worker1
BalancerMember http://127.0.0.1:8092/fp route=worker2

# If you want to use AJP instead of HTTP, uncomment the 
following 
# lines. Note the different port numbers. They can be configured 
in
# server.xml in tomcat.
#BalancerMember ajp://127.0.0.1:7091/fp route=worker1
#BalancerMember ajp://127.0.0.1:7092/fp route=worker2
</Proxy>

# Route everything coming to /fp/ into the laod balancer
# and make sure that the cookie whose value to modify have the
# name JSESSIONID.
ProxyPass /fp/ balancer://mycluster/ stickysession=JSESSIONID

######## End balancer configuration #########################

Configuring memory for the Rational Focal Point installation
The Rational Focal Point application can consume a large amount of system 
memory (RAM). It is dependent on the amount of memory assigned to the 
Tomcat server. By default, Tomcat is assigned 400 MB of memory, but this 
should be raised to about 2/3 of the available RAM on the system.
38    IBM® Rational® Focal Point™ Installation Guide



Maintaining Rational Focal Point
Memory configuration is set up in <fp>/focalpoint.conf. 

Changing the Web server port

1. See “Setting up a cluster with application server Apache Tomcat” on page 35 
step 5 b) i-iii.

2. After changing the port number, you need to restart Rational Focal Point.

Maintaining Rational Focal Point
Usually, Rational Focal Point does not require much maintenance; most of the 
application configuration is done using the web interface. This is done by 
application administrators or workspace administrators as defined by the local 
usage policies.

Log files

Tomcat

Log files for Rational Focal Point are located in <fp>/catalinabaseX/logs. 

Websphere

Wasce server logs are located in
<WASCE_HOME>/var/log/server.log

Log files for Rational Focal Point are by default located in 
<WASCE_HOME>/var/log/fp.log

To modify the focalpoint logging location in Websphere:

1. Open 
<WASCE_HOME>/repository/focalpoint/fp/1.0/fp-1.0.
war/WEB-INF/classes/fp-logging.properties

2. Modify the following entry:
java.util.logging.FileHandler.pattern=<WASCE_HOME
>/var/log/fp.log

Note: FileHandler.pattern requires an absolute path.

Monitoring Rational Focal Point
You can request the application status from the application over http. The 
following commands are available:

• http://<hostname>:8091/fp/servlet/Ping?cmd=ping 
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If the application and database are running the reply will be:

pong

If something is not working properly the reply will be:

dead

Or there will be no response at all.

• http://<hostname>:8091/fp/servlet/Ping?cmd=stats or 
http://<hostname>:8091/fp/servlet/Ping?cmd=htmlstats

This will result in an XML or HTML file describing the current application 
state.

• http://<hostname>:8091/fp/servlet/Ping?cmd=version

This will result in the application version.
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6 Upgrading to Rational Focal Point 6.4 on UNIX
This chapter contains the following topics:

• Before you start

• Upgrading Focal Point 5.4 to Rational Focal Point 6.4

• Upgrading Focal Point 6.x to Rational Focal Point 6.4

Before you start
Before you start upgrading read the chapter “Before you start” on page 23.

Note  When you upgrade to Rational Focal Point 6.4 from 5.4 or 5.4 
01 you must request a new license file from IBM Rational 
Software Support to 6.4 from 5.4 SP1, you can use the 
current license file.

Note  If you are upgrading from 5.4 on an installation running on 
Oracle, or migrating to Oracle, locate the latest version of 
focalpoint_grant.sql in <fp>/scripts/oracle, and run it 
according to the instructions in “Oracle RDBMS Support” 
on page 27 before the upgrade.

Upgrading Focal Point 5.4 to Rational Focal Point 6.4
1. Back up report images if any. 

Linux:

/usr/share/focalpoint/images

Solaris: 

/opt/FOCAfp/share/images

2. Make a note of any used custom business rules. When the installation of 
Rational Focal Point is finished, you need to request the custom business 
rules you use from IBM Rational Software Support for compatibility reasons. 
Only the common business rules are included in the installation. The 
common business rules are: ChoiceAttributeText, LinkByText, LinkInfo, 
LinkListAttributeSum, ListAttributeSum, MailImport, MatrixWriter, 
SetChoice, TextLog, and TrafficLight.

Linux:
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/usr/share/focalpoint/formulas

Solaris: 

/opt/FOCAfp/share/formulas

3. Get the package from the IBM Rational Focal Point Support Download site. 
The only package you need for the upgrade is focalpoint-6.4.sh.

4. Stop the application.

Linux:

service tomcat55 stop

Solaris:

/etc/init.d/focalpoint stop

5. Take a database backup. If possible, copy the backup file to another system. 
Please refer to the backup instructions of the Installation Guide for Focal 
Point 5.4.

6. Remove the focalpoint package:

Linux:
rpm -ev focalpoint
Solaris: 
pkgrm FOCAfp

7. Install the new focalpoint package and configure it. See “Installing Rational 
Focal Point” on page 26, and “Configuring the application server” on page 
31.

8. When you have received the custom business rules from IBM Rational Focal 
PointSupport, log on to Rational Focal Point and go to Advanced > 
Business Rules. Import the custom business rules files to the database. 
Instructions are available in the help.

9. In Rational Focal Point, go to General > Report Images to import the 
backed up images from step 2 into the database. Instructions are available in 
the help.

10. If you have any saved baselines in your database, you need to migrate them to 
the new architecture in Rational Focal Point 6. In Rational Focal Point, go to 
Advanced > Migrate Baselines. Instructions are available in the help.
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Upgrading Focal Point 6.x to Rational Focal Point 6.4

Preparations: 
• Back up the configuration files <fp>/focalpoint.conf and 

catalinabase1/conf/server.xml in a directory outside the Focal 
Point installation.

• Ensure that the Postgres or Oracle database is running.

• Locate the Rational Focal Point installer at the IBM® Rational® Solutions 
for Enterprise Lifecycle Management DVD, or download Rational Focal 
Point 6.4 Installer for Linux or Solaris from the IBM Rational Focal Point 
Support Download site.

• From Rational Focal Point 6.4 Installer, extract focalpoint-6.4.sh to 
a file directory of your choice, e.g. <installerdir>. 

Upgrading: 

1. Go to the directory where Focal Point 6.x is installed. Make sure that you 
have write permissions in that directory

2. Run the self-extracting installer by issuing the command

sh <installerdir>/focalpoint-6.4.sh

You will be asked to read and understand the license agreement. Make sure you 
do so. If you do not agree, then answer no and press Enter and nothing will be 
installed on your system. Installation can be started again at any time. If you 
agree with the license terms, then answer yes and press Enter. 

3. Restore the configuration files by moving the backup of 
catalinabase1/conf/server.xml and 
<fp>/focalpoint.conf back to their original locations.
Note: If the application server or servlet container is Tomcat, in 
catalinabase/conf/server.xml, for the resource 
jdbc/focalpoint, verify that defaultAutoCommit is set to 
true. 

4. Configure the newly installed focalpoint package, see “Configuring Focal 
Point” on page 29.

Rational Focal Point is now upgraded to 6.4.
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7 Backing up 
It is essential to regularly back up the database. For more information on how to 
backup a PostgreSQL database, please visit http://www.postgresql.org.

This chapter contains the following topics:

• Backing up and restoring the PostgreSQL database on Windows

• Backing up and restoring the PostgreSQL database on Unix

Backing up and restoring the PostgreSQL database on Windows
This chapter describes how to manually backup the database. Make sure there is at 
least one free database connection available, before configuring the backup.

Manually backing up the PostgreSQL database
To create a backup:

1. Click Start Menu> All Programs > PostgreSQL 8.1 > pgAdmin III.

The pgadmin III window is displayed. 

2. Right-click on the database name, select Connect and enter the password for 
the database. This is the password you provided on the Initialize database 
clusters screen when you installed the PostgreSQL database.

3. Right-click on the focalpoint database and select Backup.
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The Backup Database dialog box is displayed.

4. Type a path and name for the backup file, or click ... to select a folder.

5. Click OK.

A backup file is created.

6. Click Done.

Restoring a PostgreSQL database backup file
Make sure that Rational Focal Point is stopped before you restore the database.

1. Click Start Menu > All Programs > PostgreSQL 8.1 > pgAdminIII for 
the database. This is the password you provided on the Initialize database 
clusters screen when you installed the PostgreSQL database.

2. Right-click on the focalpoint database and select Restore.

The Restore Database dialog box is displayed.
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3. Browse to the backup file you want to restore.

4. Click OK.

The database is restored.

5. Click Done.

6. Open the SQL prompt and run the following query:

delete from node;

If you are restoring the files to a different Rational Focal Point server, you have 
to copy any special expression class files from your old installation to your new 
installation. (The generic built-in expression class files come with the 
installation.) Special expression class files are stored in the Rational Focal Point 
installation folder in tools\formulas and tools\images. Rational Focal Point 
is installed to C:\Program Files\IBM Rational\IBM Rational Focal 
Point by default.

7. Start Rational Focal Point again.

Backing up and restoring the PostgreSQL database on Unix
You must make sure the database is backed up properly. The database backup 
only contains data stored on the database, the application is not backed up. Make 
sure that the <fp> directory is backed up so that your configuration can be 
restored. (If you have made any changes to the maximum number of 
connections in Rational Focal Point or the PostgreSQL database, make sure 
there is at least one free database connection available, before configuring the 
backup. Default maximum number of connections in Rational Focal Point is 30 
and in PostgreSQL the default number is 100. Note that two nodes means 60 
connections, etc.)
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8 Troubleshooting

Using Japanese characters in Rational Focal Point
If you want to use Japanese characters in Rational Focal Point, you must install 
files for East Asian languages.

On Windows XP:

1. Click Start Menu > Control Panel and select Date, Time, Language, and 
Regional Options, then select Regional and Language Options.

2. On the Languages tab, select the check box for Install files for East Asian 
languages.

3. Click OK. You will need the Windows CD to complete this step.

4. Restart the computer.

On Windows 2003 Server:

1. Click Start Menu > Control Panel and select Regional and Language 
Options.

2. On the Languages tab, select the check box for Install files for East Asian 
languages.

3. Click OK. You will need the Windows CD to complete this step.

4. Restart the computer.
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9 Single Sign-On
This chapter contains the following topics:

• Introduction

• Ping servlet

• Synchronization servlet

• Web Services

Introduction
The Single Sign-On (SSO) feature allows a user who is logged on to a corporate 
network to be automatically logged on to the Rational Focal Point server. This 
means that it is not necessary to administrate and remember a separate password 
for Rational Focal Point.

Note  For information on setting up SSO, visit the online help in 
Rational Focal Point.

In some cases it may be possible to call the server without being logged in to the 
SSO solution, for example when retrieving the server status or using the Web 
Services interface. To do this, it is necessary to allow some URLs to pass through 
the SSO Proxy without authentication.

Ping servlet
To allow tools or users to retrieve server status information, calls to the Ping 
servlet must be allowed to pass through the SSO solution without authentication.

http(s)://<your Rational Focal Point server 
URL>/fp/servlet/Ping

For example:

http://focalpoint.examplecompany.com/fp/servlet/Ping?cmd=ping

Synchronization servlet
To allow integrations that use the Focal HUB to work through the SSO solution, 
calls to the Synchronization servlet must be allowed to pass through the SSO 
solution without authentication.

http(s)://<your Rational Focal Point server 
URL>/fp/servlet/Synchronization
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For example:

http://focalpoint.examplecompany.com/fp/servlet/Synchronization

Web Services
To allow integrations that use Web Services to work through the SSO solution, 
calls to the following two URLs must be allowed to pass through the SSO 
solution without authentication.

http(s)://<your Rational Focal Point server 
URL>/fp/services/FocalPoint
http(s)://<your Rational Focal Point server URL>/fp/servlet/Wsdl

For example:

http://focalpoint.examplecompany.com/fp/services/FocalPoint and
http://focalpoint.examplecompany.com/fp/servlet/Wsdl
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If the self-help resources have not provided a resolution to your problem, you can 
contact IBM® Rational® Software Support for assistance in resolving product 
issues.

Note  If you are a heritage Telelogic customer, a single reference site 
for all support resources is located at 
http://www.ibm.com/software/rational/support/telelogic/

Prerequisites
To submit your problem to IBM Rational Software Support, you must have an 
active Passport Advantage® software maintenance agreement. Passport 
Advantage is the IBM comprehensive software licensing and software 
maintenance (product upgrades and technical support) offering. You can enroll 
online in Passport Advantage from 
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html

• To learn more about Passport Advantage, visit the Passport Advantage FAQs 
at 
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_q
uickguides.html.

• For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational 
Software Support, you must additionally:

• Be a registered user on the IBM Rational Software Support Web site. For 
details about registering, go to http://www.ibm.com/software/support/.

• Be listed as an authorized caller in the service request tool.

Submitting problems
To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a problem 
to IBM, you are asked to supply a severity level. Therefore, you need to 
understand and assess the business impact of the problem that you are 
reporting.
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Use the following table to determine the severity level.

Severity Description

1
The problem has a critical business impact: You are unable to 
use the program, resulting in a critical impact on operations. 
This condition requires an immediate solution.

2
This problem has a significant business impact: The program 
is usable, but it is severely limited.

3
The problem has some business impact: The program is 
usable, but less significant features (not critical to 
operations) are unavailable.

 4
The problem has minimal business impact: The problem 
causes little impact on operations or a reasonable 
circumvention to the problem was implemented.

2. Describe your problem and gather background information, When 
describing a problem to IBM, be as specific as possible. Include all relevant 
background information so that IBM Rational Software Support specialists 
can help you solve the problem efficiently. To save time, know the answers to 
these questions:

• What software versions were you running when the problem occurred?

To determine the exact product name and version, use the option 
applicable to you: 

• Start the IBM Installation Manager and select File > View Installed Packages. Expand a 
package group and select a package to see the package name and version number. 

• Start your product, and click Help > About to see the offering name and version number. 
• What is your operating system and version number (including any 

service packs or patches)? 
• Do you have logs, traces, and messages that are related to the problem 

symptoms? 
• Can you recreate the problem? If so, what steps do you perform to 

recreate the problem? 
• Did you make any changes to the system? For example, did you make 

changes to the hardware, operating system, networking software, or 
other system components? 
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• Are you currently using a workaround for the problem? If so, be 
prepared to describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit 
your problem to IBM Rational Software Support in the following ways:

• Online: Go to the IBM Rational Software Support Web site at 
https://www.ibm.com/software/rational/support/ and in the Rational 
support task navigator, click Open Service Request. Select the 
electronic problem reporting tool, and open a Problem Management 
Record (PMR), describing the problem accurately in your own words.

For more information about opening a service request, go to 
http://www.ibm.com/software/support/help.html

You can also open an online service request using the IBM Support 
Assistant. For more information, go to 
http://www.ibm.com/software/support/isa/faq.html.

• By phone: For the phone number to call in your country or region, go 
to the IBM directory of worldwide contacts at 
http://www.ibm.com/planetwide/ and click the name of your country 
or geographic region. 

Through your IBM Representative: If you cannot access IBM Rational 
Software Support online or by phone, contact your IBM Representative. If 
necessary, your IBM Representative can open a service request for you. You can 
find complete contact information for each country at 
http://www.ibm.com/planetwide/.
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Appendix K: Notices
© Copyright 1997, 2009

U.S. Government Users Restricted Rights - Use, duplication, or disclosure 
restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A. 
IBM may not offer the products, services, or features discussed in this document 
in other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right may 
be used instead. However, it is the user's responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send written license inquiries to: 

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A. 

For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send 
written inquiries to: 

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
3-2-12 Roppongi, Minato-ku Tokyo 106-8711 

The following paragraph does not apply to the United Kingdom or any 
other country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
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Some states do not allow disclaimer of express or implied warranties in certain 
transactions, therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for this 
IBM product and use of those Web sites is at your own risk. 

Licensees of this program who wish to have information about it for the purpose 
of enabling: (i) the exchange of information between independently created 
programs and other programs (including this one) and (ii) the mutual use of the 
information which has been exchanged, should contact: 

Intellectual Property Dept. for Rational Software
IBM Corporation
1 Rogers Street
Cambridge, Massachusetts 02142
U.S.A.

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 

The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer 
Agreement, IBM International Program License Agreement or any equivalent 
agreement between us. 

Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments 
may vary significantly. Some measurements may have been made on 
development-level systems and there is no guarantee that these measurements 
will be the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. Actual results 
may vary. Users of this document should verify the applicable data for their 
specific environment. 

Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy of 
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Trademarks
performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products.

This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental. 

If you are viewing this information softcopy, the photographs and color 
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions 
worldwide. Other product and service names might be trademarks of IBM or 
other companies. A current list of IBM trademarks is available on the Web at 
www.ibm.com/legal/copytrade.html.

Linux is a registered trademark of Linus Torvalds in the United States, other 
countries, or both.

Microsoft and Windows are registered trademarks of Microsoft Corporation in 
the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and 
other countries.

Java and all Java-based trademarks and logos are trademarks of Sun 
Microsystems, Inc. in the United States, other countries, or both.

Other company, product or service names may be trademarks or service marks 
of others.
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